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SAP Fieldglass Services User Guide 
 

Reference Guide for Small Suppliers 
Individual or small firm/organization with 8 or fewer W-2 employees. Also known as Freelancers or 
Independent Contractors. 
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FIELDGLASS SUPPORT 
 

McGraw Hill utilizes Managed Services Provider (MSP) AgileOne to manage the all temporary and 

freelance workers within McGraw Hill. AgileOne provides a dedicated team accessible to all McGraw 

Hill users, including Independent Contractors/Freelances, Temporary Workers, and McGraw Hill 

Managers. 

 

AgileOne utilizes online software to manage all activity related to all freelance and temporary labor. 

The Fieldglass system is made available to any user who is using or providing services or labor to 

McGraw Hill. 

 

The AgileOne onsite team is available 8:00am – 5:00pm Central time.  

Contact the AgileOne onsite team via email: contractor.ts@mheducation.com 

 

Problem Contact 

Password Reset Fieldglass Help Desk 

Email: fieldglasshelp@sap.com 
Phone: 866-467-4833 

Invoice Submittal AgileOne Onsite Team 

Contractor.TS@mheducation.com  

Confirm Payment Method AgileOne Onsite Team 

Contractor.TS@mheducation.com 

Changes to Payment Method or Accounts AgileOne Onsite Team 

Contractor.TS@mheducation.com 

Physical Address Update AgileOne Onsite Team 

Contractor.TS@mheducation.com 

 

 

ACCESSING FIELDGLASS 
 
A Supplier Registration email will be sent to the email address provided. 
 
1. After reviewing the message, select Click Here to be directed to the Fieldglass registration. 

2. Complete all mandatory fields including Address, Username, Password, and Secret Question. 
Click Next. 

3. Complete the End User Agreement, then select Accept and Continue. 

mailto:contractor.ts@mheducation.com
mailto:fieldglasshelp@sap.com
mailto:Contractor.TS@mheducation.com
mailto:Contractor.TS@mheducation.com
mailto:Contractor.TS@mheducation.com
mailto:Contractor.TS@mheducation.com
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User accounts for additional users within your company can be created from the Admin menu. 

1. Click Admin. 

2. Select User from the User menu section. 

3. Click New. 
 
IMPORTANT: When a new user is created, the Admin user is prompted for the user's supervisor, 
which is required. Therefore, it is required to add users in a "top down" fashion, so upper-level 
supervisors are added first. Alternately, the SAP Fieldglass Administrator can be selected as the 
supervisor for all users and update this information later.  

4. Complete the form, then click Add. The new user will receive a registration email from Fieldglass. 

 

LOGGING IN TO FIELDGLASS 
 
Users sign in to Fieldglass directly from their internet browser. 
 
1. Navigate to www.fieldglass.net 

2. Enter the Username and Password. 
Note: If you have forgotten your username or password, click Need help signing in? for 
assistance. 

3. Click Sign In. The landing page is the Dashboard. 

 

BASIC NAVIGATION 
 

 
 

 
Navigation 
 

1. At the top of the screen, the system displays the initials of the current user. If a user has linked 
accounts or is a delegate for another user, clicking on the initials will display linked accounts. If 
there are no accounts linked, clicking the user’s name will only display the profile and 
preferences options. 

2. The menu bar provides access to the various functions within Fieldglass. To view the options 
within each menu, click the menu name. The available options will be displayed for each menu. 

To navigate to an item in the menu, click the desired option. Click the  Home icon on the 

http://www.fieldglass.net/
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menu bar or the Fieldglass logo at any time to return to the Fieldglass home page. 

3. Work Items are transactions that require action in Fieldglass. Click the Work Items menu to 
view all active work items for your user account. Messages are another way to view 
alerts/notifications that the Fieldglass tool will automatically send out to managers tracking 
various activities within the tool. 

4. Companies may display a customized announcement on the Home page. Announcements may 
be visible to buyer users, supplier users, or to workers.  

Menus 
Navigating in Fieldglass is accomplished through Menus. Menus are listed at the top of every screen 
in Fieldglass: 
 

Fieldglass Menus 

Item Description 

Home The Home page is your starting point within Fieldglass. The Fieldglass home 
page provides you quick access to messages and items requiring your attention 
(work items). Click the Home menu at any time to return to the Fieldglass home 
page. 

View Use the View menu to locate and view items, such as SOWs. For example, if 
you select Statement of Work from the View menu, the system shows the 
current SOWs for a specified date range. You can use the search options at the 
top of each list to filter the items that are displayed.   

Create Use the Create menu to create new transactions in Fieldglass. The items you 
can create will be based on your specific system configuration.  

Analytics Use the Analytics menu to run or create reports. 

Work Items  Use the Work Items menu to display a list of current items that require 
action. 

Message Center Use the Messages  menu to view a list of messages that have been sent to 
you.  

Admin Use the Admin icon   to access the Admin menu.   

Help Use the Help icon to access Online Help, Release Notes, and the 
Reference Library. In addition, the Help menu allows you to view contact 
information for Fieldglass support as well as the Fieldglass application version. 

Settings Use the Initials  icon to adjust your personal preferences such as date 
format, time zone & display name, or to update your password. 
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Tabs 

Tabs are used when viewing a Statement of Work to group related information. Click each tab to view 
additional information about the document. 

 

Tab Label Description 

Details The tab contains the description of the project, 
the total budget summary, and the attachment 
that contains the signed SOW.  
 
The signed SOW can be downloaded as many 
times as necessary. Upon revision, a new 
attachment will appear in addition to the original. 

 
Manage This tab contains activity items related to the 

document generation. No action is needed from 
you on this tab. 

 
Clauses This tab contains the legal clauses agreed to 

upon signature of the Statement of Work.  
 
The clauses viewed here are the same as those in 
the document attached in the Details tab. 
 

Deliverables/Milestones, Due Date & Fees This tab contains the list of individual 
Milestones/Deliverables (Fees) associated with 
the project. The Fee detail can be viewed by 
clicking on the Name of the Fee.  
 
This tab also contains the list of Invoices already 
charged to the SOW and the Invoice status. 
 

Related This tab contains the list of items that are related 
to this Statement of Work. Typically, only the 
invoices charged against the Statement of Work 
will appear in this tab. 
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GETTING STARTED 
 
Changing Password 
 
Your Fieldglass password can be updated at any time. 

1. Click on the initials icon  in the top right of the page. Select My Profile. 
The Personal Settings page will open, with the My Profile tab displayed. 

2. Click Change Password in the Account Information section. The Change Password dialog box is 
displayed. 

3. Enter new password information, then click Change.  

 

Updating Contact Information 
 
You can change your Fieldglass contact email address and set up a list of email addresses to be 
included in the Cc: field of all email notifications sent from Fieldglass. 

1. Click on the people icon  in the top right of the page. Select My Profile. 
The Personal Settings page will open, with the My Profile tab displayed. 

2. Click Edit in the section where your name is displayed. 
The My Profile – Basic Information page is displayed. 

3. In the Email field, enter the email address where all email notifications from Fieldglass should be 
sent. 

4. In the Cc: Email Addresses field, enter any email addresses that should be included in the Cc: 
field of all Fieldglass notifications. Separate each address with a comma or a semicolon. 

5. Click Update to save your changes. 
 

Updating Fieldglass Preferences – Notification Emails 
 

1. Click on the people icon  in the top right of the page. Select My Preferences. 
The Personal Settings page will open, with the My Preferences tab displayed. 

2. Click Edit to the right of Locale to change time zone. 

3. Scroll down to Messaging section. Click Edit. 

4. On the My Preferences – Messaging page, you may indicate whether you want Notification, Work 
Item, Alert, Broadcast, Chat (Contingent), Chat (services) or Starred messages sent to your 
email address. 

Updating Proxy Information 
 
A proxy is an individual who can act on a User’s behalf in the Fieldglass system when the User is 
unavailable to do so. 
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1. Click on the people icon  in the top right of the page. Select My Profile. 
The Personal Settings page will open, with the My Profile tab displayed. 

2. Scroll to the Proxy section, then click Edit. 
 

3. To add a new Proxy, click Add Proxy. The Add Proxy dialog box is displayed. 
 

4. Enter the requested information, then click Add. 
 

Add Proxy Field Definitions 

Field Description 

Work Items Under Work Items, select All to allow the proxy to act on all your work items.  

 

Select Time Sheet to allow the proxy to approve time sheets only. 

Proxy In the Proxy list, select the proxy you want to add. By default, the available users 
will be anyone with your same user role or with the Administrator user role.  

 

Once the proxy is selected, the value for Role will automatically populate. 

Start Date 
End Date 

Click the calendar icons next to the Start Date and End Date fields to establish the 
period during which this person should be your active proxy.  

 

If you leave the Start Date blank, the person selected will become your proxy as 
soon as you click Add.  

 

If you leave the End Date blank, the person will remain your proxy until you remove 
him or her. 

 
5. To change any existing Proxy information, click Edit. To remove an existing proxy, click Remove. 

 
 

COLLABORATION 
 
Collaboration is the process wherein the Supplier and the McGraw Hill project contact can review the 
Statement of Work and negotiate pricing and/or Milestones/Deliverables and Due Dates. Fieldglass 
allows the Statement of Work to pass between the two parties as many times as necessary to come to 
agreement.  
 
Contract clauses cannot be negotiated in Fieldglass. If the Supplier requires a change in the legal 
language of the clauses, the McGraw Hill project contact will engage the internal McGraw Hill Contract 
Management team for guidance.  
Note: Negotiating the clauses of the contract will increase the turnaround time for completing the 
transaction. 
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Reviewing a Statement of Work 
 
1. Login to Fieldglass 

2. Select Work Items then Statement of Work – Review. 

3. Click on the Statement of Work ID to be reviewed. 

4. Select Respond to review the SOW and to negotiate Deliverables/Milestones, Due Dates or 

Fees. Click the edit icon  to make changes to the items. 

Suppliers may also add a reference number, change the primary contact, and add any comments to 
the Buyer. 

If the Supplier opts to negotiate Deliverables/Milestones, Due Dates or Fees, it is strongly 
recommended that the supplier detail those changes in a comment to the Buyer. The comments 
create a record of the negotiation between parties for both to reference at a later date. 

5. When review is complete, click Continue, then Submit.  

The Buyer will review and either Accept or return to the Supplier for additional negotiation. After both 
parties are satisfied with the terms of the Statement of Work, the Buyer will forward the Statement of 
Work internally for approval. 

 

ACCEPTING A STATEMENT OF WORK 
 
After all internal non-financial approval is complete, the Statement of Work will be submitted to the 
Supplier for final review and acceptance. There is no additional negotiation at this stage. 
 
1. Select Work Items, then Statement of Work – Accept OR 

 
Select View, then Statement of Work. 

2. Click on the Statement of Work ID to be reviewed. 

3. Click Accept or Decline as appropriate. 

a. If Declined, the Supplier will be required to provide a reason for declining. 

4. A confirmation that the Statement of Work has been successfully submitted will display in a green 
ribbon on the Summary page. 

 
Accepting a Statement of Work does not indicate approval to begin work or invoicing. After acceptance, 
McGraw Hill will then secure the financial approval necessary to ensure the funds for the project are 
available.  
 
Statements of Work valued at $100,000 or more will require a DocuSign process to be completed before 
invoicing can occur. 
 
Fieldglass will send an approval notification via email confirming when all necessary approvals have been 
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completed and alerting the Supplier that work may begin. The status of the SOW in Fieldglass will be 
updated to Approved upon release for invoicing. 
 

STATEMENT OF WORK REVISIONS 
 
In the event that a revision is required for an existing Statement of Work, the revision will be reviewed in 
a similar manner to the original acceptance. 

 
After all internal non-financial approval is complete, the Statement of Work Revision will be submitted 
to the Supplier for final review and acceptance. There is no additional negotiation at this stage. 
 
1. Select Work Items, then Statement of Work Revision – Accept OR 

 
Select View, then Statement of Work. 

2. Click on the Statement of Work ID to be reviewed. 

3. Click Accept or Decline as appropriate. 

a. If Declined, the Supplier will be required to provide a reason for declining. 

4. A confirmation that the Statement of Work Revision has been successfully submitted will display in 
a green ribbon on the Summary page. 

 
 

RETRIEVING STATEMENT OF WORK CLAUSES (CONTRACT) 
 

After all necessary approvals and signatures are completed, Fieldglass will automatically create a .pdf 
document containing the terms, deliverables/milestones, due dates, and fees, and the electronic 
signatures of McGraw Hill and the Supplier. 
 
This document will be re-issued upon revision of the Statement of Work. The original document will 
remain available for download. 

 
1. Login to Fieldglass 

2. Select View then Statement of Work. 

3. Click the Statement of Work ID desired. The Statement of Work will open on the Details page. 

4. Scroll to the bottom of the page. 

5. Under the Attachments header is a link to download the Statement of Work contract. 
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INVOICING 
 

• Creating an invoice is known as creating a Deliverable/Milestone or Fee.  

• Fees can be generated for all or a partial amount of Units. If a partial amount is billed, additional 
invoices (Fees) can be submitted up to the maximum amount allowed in the SOW. 

o Example: The SOW has 100 available Units. You may invoice for all 100 units as one 
Fee, or you may invoice 4 Fees of 25 units each. 

• Effective October 2020, a 2.2% administrative fee will be applied to all invoices processed in 
Fieldglass. This fee will be deducted from the total invoice amount before payment is issued to 
the Supplier. 

NOTE: The document located here contains additional detail for submitting Fieldglass invoices. 

 

Deliverable/Milestone or Fee Creation 
 
1. Login to Fieldglass. 

2. Select View then Statement of Work. The list of SOWs associated to the logged in supplier will be 
listed.  
 
Items that are in the status Approved are active and ready for Fee creation. 

3. Click on the Statement of Work ID for the item to be viewed. The SOW ID is a 12-digit code that 
begins with MHETQ (MHETQXXXXXXXX). 
 
Note: The dates in the Period fields can be ignored. Fieldglass auto-populates these fields based 
on your active SOWs. 

4. Click Actions. A menu will load. 

5. Select Create Milestone/Deliverable or Fee. 

6. Enter the Effective Date of your invoice. 

7. Select +Add Deliverable/Milestone or Fee. 

8. From the drop-down menu that appears, select the item to which the Fee is being charged. 

9. Enter the Description of the services performed. 

10. Enter the number of Units to be charged. To confirm the total dollar amount being charged, click 
Calculate Deliverable/Milestone or Fee Amount. 

11. Click Continue. 

12. Review the displayed information. If correct, select Submit. If changes are necessary, click Make 
Changes. 

 

https://s3.amazonaws.com/ecommerce-prod.mheducation.com/unitas/corporate/suppliers/creating-fieldglass-invoices-and-fieldglass-faq.pdf
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Invoice Revisions  
 
In the event an invoice has been submitted and approved with an error, Suppliers may create a 
Revision to amend the invoice to reflect the proper amount. 
 
1. Login to Fieldglass. 
2. Select View, then Statement of Work. 
3. Click on the SOW ID number to view details. 
4. Select the Milestones/Deliverables, Due Dates & Fees tab. 
5. Filter the table to view only items that have been Invoiced. 
6. Click on the Name of the item which requires changes. 
7. Click Edit, then Revise. 
8. Update the value of the invoice to the correct amount or update the Fee it has been allocated to. 
9. Click Continue, review the information, then Submit. 

 

REASON CODES 
 

Reason codes are used in Fieldglass when declining or rejecting items assigned to the Supplier user. 
Reason codes are generated by the Supplier Admin user and can be updated at any time.  

 
1. Login to Fieldglass 

2. Select the Admin  icon. 

3. From the Admin menu, select Reason under the Configuration heading. 

4. Click New. 

5. Select the module the Reason will be applied to. 
Example: Statement of Work, Invitation. 

6. Confirm the Type. Items can be Withdrawn and Declined, dependent on the function. 

7. Enter the Reason Code, then click Add. 

Additional Reason Codes can be input using steps 4 through 7. 
 
 

ANALYTICS 
 
Fieldglass contains a reporting function available to all Suppliers. There are several pre-defined 
reports that can be run to analyze the Statements of Work and their history. 
 
To run a pre-defined report: 

 
1. After logging in, select Analytics then All Reports. 

2. Click the desired report Name. 
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3. Review the Filter options and update to desired settings. 

4. Select the report Output Format. 

5. Click Run. The report will be automatically generated in the selected format.  
Depending on the internet browser being used and its associated settings, users may be 
prompted to download or save the report, or the item may be automatically downloaded. 


